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●本説明書はFC-GEシリーズカメラ（FC1250GE／FC1650GE／FC2200GE／FC5200GE／FC11000GE／他）をPC

と接続しソフトウエアをインストールして画像を取得する方法を中心に説明しています．

その他のカメラブロック部分の取扱方法については別冊の”ＣＣＤビデオカメラ取扱説明書”をご参

照下さい．
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3 第３版 ﾊﾞｰｼﾞｮﾝｱｯﾌﾟに伴う変更 "7.GEVPlayer の起動と画像ｷｬﾌﾟﾁｬｰ"他 2009-07-28 M09728A CD-ROM VER 1.1～
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5 第５版 説明の追加 GenICamに関する解説追加 2009-12-18 M09C18 ↑

6 第６版 ﾊﾞｰｼﾞｮﾝｱｯﾌﾟに伴う変更 SDKのﾊﾞｰｼﾞｮﾝｱｯﾌﾟに伴う変更 2011-04-11 M11411 CD-ROM VER 2.0～

7 第７版 4章／図解の変更 OS環境 Windows 7 対応の為 2011-07-07 M11707 CD-ROM VER 2.1～

8 第８版 訂正 誤記訂正 2011-10-06 M11A06 ↑

本説明書中での付加表記について

（注） … ご使用に際してご注意頂きたい点を解説しています．

［解説］… 本カメラの動作を理解する上で必要と思われる事柄を解説しています．
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はじめに

FC-GEシリーズカメラは GigE Vision 規格対応のギガビットイーサネット接続型カメラです．

・GigE Vision

GigE Visionは AIA（Automated Imaging Association）のメンバー各社が中心となってまとめられたギガビットイーサネットインター

フェース接続に適合したのカメラ画像転送用の標準インターフェースです．

GigE Vision規格を採用する事によって大容量の映像データをローコストな汎用LANケーブルを用いて伝送出来ます．また画像データは

非圧縮でかつ高速に伝送可能で，伝送距離もリピータなしで通常最大100mまで可能です．

尚，GigE Vision の詳細については 次の”AIA”のホームホームページをご参照ください．

http://www.machinevisiononline.org/

・iPORT GigE IP エンジン

当シリーズカメラの画像伝送インターフェース部分にはカナダ Pleora Technologies 社の GigE 対応IPプロトコルエンジンである

iPORT が搭載されています．カスタムアプリケーションの開発はこの iPORT 用のソフトウエア開発キット（SDK）を用いて行います．

※”イーサネット”（Ethernet）は 米国 Xerox Corp.の登録商標です．

※”iPORT” はカナダ Pleora Technologies 社の登録商標です．

（注）本取扱説明書の中では SDK ”eBUS SDK 2.0.1.1951”，”eBUS-Vision Package 4.0.1.1951”の内容に従った説明を致しており

ます．文中の図の内容の詳細はバージョンの改訂とともに実際の表示と多少異なる場合が有ります．

（注）”eBUS-PureGEV Package 2.0.1”以降では 従来の ”eBUS-PureGEV SDK”が ”eBUS SDK”と省略表記されます．

配布CD-ROMに含まれるSDKは（CD-ROM Ver.2.0以降では）”eBUS SDK”， ”eBUS-Vision Package”となります．

＜配布CD-ROM Ver.2.0に含まれるSDK＞

”eBUS_SDK_2.0.1.1951” （従来の”eBUS-PureGEV Package”に相当）

”eBUS-Vision_Package_4.0.1.1951”

１．使用環境

FC-GEシリーズカメラを使用するにあたりハードウエア及びソフトウエアの使用環境をご確認下さい．

（１－１）カメラ，電源及びカメラケーブル

別冊のビデオカメラ取扱説明書の”操作方法”の項目をご参照下さい．

（１－２）ＰＣ（コンピュータ）

PCについては特に100万画素以上の高画素カメラを接続する場合，以下にあげる高スペック品の使用を推奨致します．

・OS ：Microsoft Windows XP(32bit版)（SP2以上 ※SP3以上を推奨）または Vista(32bit版)

Microsoft Windows 7 (32bit版／64bit版）

(Windows 2000 以前のOSは使用不可)

・PC ：CPU Core2 Duo 2.4GHz 以上

・ﾒｲﾝﾒﾓﾘ ：2GB以上

・ﾋﾞﾃﾞｵｶｰﾄﾞ ：ｸﾞﾗﾌｨｯｸﾒﾓﾘ 256MB DDR2以上／ｲﾝﾀｰﾌｪｰｽ：PCI Express bus x 16 以上 （※画像表示処理が必要な場合は必須）

（注）通常のマザーボード上に実装されているオンボードのグラフィック機能を使用した場合正常な画像表示が出来ない場合が

有ります．

（１－３）ＬＡＮカード（NIC）

本シリーズカメラから出力される画像を高速にキャプチャーするにはIntel社製のPro/1000 LANカード（NIC）を使用するかその互換

品のチップセット（下一覧表）を搭載したLANカードを使用して下さい．

マザーボード内蔵のLAN I/F機能を使用する場合はこのIntel社製のPro/1000 LANカードのチップセット互換品（下一覧表）を搭載し

ているマザーボードを使用して下さい．

弊社推奨ＬＡＮカード 製品名：intel PRO/1000GT デスクトップ・アダプタ／型式：PWLA8391GT （1CH接続用，PCIバス）

intel PRO/1000MT デスクトップ・アダプタ／型式：PWLA8492MT （2CH接続用，PCIバス）

DATA（12／10/8bit)
RJ-45 コネクタ

GigE I/F

iPORT

SYNC
（FVAL，LVAL ，CLK）

SERTC
SERTFG

CAMERA BLOCK
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［互換チップセットの一覧］

82540 EM - 100E，82540 EM – 1015，82540 EP – 1016，82540 EP - 101E，82541 EI – 1013，82541 EI – 1018，82541 ER – 1014，

82541 ER – 1078，82541 GI – 1076，82541 GI – 1077，82541 PI - 107C，82545 EM - 100F，82545 EM – 1011，82545 GM – 1026，

82545 GM – 1027，82545 GM – 1028，82546 EB – 1010，82546 EB – 1012，82546 EB - 101D，82546 EB – 1079，82546 EB - 107A，

82546 EB - 107B，82546 EB - 108A，82546 GT - 1099，82546 GT - 10B5，82547 EI - 1019，82547 EI - 101A，82547 GI - 1075，

82571 EB - 105E，82571 EB - 105F，82571 EB - 1060，82571 GB - 10A4，82572 E - 108B，82572 E - 108C，82572 EI - 107D，

82572 EI - 107E，82572 EI - 107F，82572 EI - 10B9，82573 L - 109A

（１－４）ｅＢＵＳドライバとｉＰＯＲＴ ＳＤＫ（ソフトウエア開発キット）

カメラ製品の添付CDに収録のもの．

Pleora／ eBUS-Vision Package （eBUS-Vision_Package_4.0.1.1951.exe ）

Pleora／ eBUS SDK （eBUS_SDK_2.0.1.1951.exe）

（注）添付のＳＤＫのバージョンはバージョンアップにより変更される場合が有ります．

（１－５）FCTool （Ver.1.00 以上）

カメラ製品に添付CDに収録のもの．または弊社ＨＰからダウンロードしたもの．

竹中システム機器／ FCTool (Ver.1.00) （FCTool_V100.zip）

弊社製のＦＣカメラ専用シリアル通信制御ソフトウエア（添付CDに収録したもの，または弊社HPよりダウンロードしたもの）

（注）eBUS SDK（従来の”eBUS-PureGEV Package”）の開発環境やGenICam規格に対応したサードパーティー製画像処理ソフトウエア

を用いてGenICam API によるカメラパラメータ設定のみを行う場合は必要有りません．

（１－６）ヌルモデムエミュレータ（Null-modem emulator）

カメラ製品に添付CDに収録のもの．

本シリーズカメラをシリアルコマンドを用いて通信制御する際に画像キャプチャー評価用ソフトウエアの”Coyote”と外部シリアル

コントロール用通信ソフト（FCToolなど)を仮想ポートで接続する際に使用するソフトウエアです．

添付ＣＤにはGPL ライセンスソフト（フリーソフトウエアの一形態）であるヌルモデムエミュレータソフト”com0com”を使用します．

このソフトウエアの使用や再配布などについてはこのソフトウエアをインストールする際に表示される”License Agreement”をご参

照下さい．

sourceforge.net／ com0com Null-modem emulator （com0com-2.1.0.0-i386-chk.zip）

”com0com”についての詳しい情報は次のURLより入手出来ます．

http://sourceforge.net/projects/com0com/

（注）GenICam API によるカメラパラメータ設定のみを行う場合は必要有りません．

（注）このソフトウエアのソースファイルは全て公開されており，上記URL のサイトより入手する事が可能です．インターネット接

続の設備が無いなどの理由でこのソースファイルを入手出来ない際は弊社までご連絡頂ければ別途郵送などの手段で送付させ

て頂きます．

※恐れ入りますが送付の際の送料は実費にて請求させて頂きますのでご了承願います．

（注）このソフトウエアを再配布する場合はソースファイルを添付するか入手の手段を提供する事が義務づけられています．

詳しくは上記URL にアクセスの上ご確認願います．

尚，上記のソフトウエア以外にも添付のCoyoteの”Software Guide”に記載されている様にヌルモデムエミュレータは以下のHPで紹

介されているもの（またはその他のソフトウエア）も使用出来ます．”Virtual Serial Port Kit”は有償製品となっています．

http://www.virtual-serial-port.com/ （Virtual Serial Port Kit）

（１－５）インターネット接続環境

ご使用頂くＰＣによってはこの製品に添付しているソフトウエアをインストールさせたり動作させる為に，ＯＳのバージョンアップ

用パッケージ（Windows XP SP3など）やツールソフトウエアなどをインターネットを接続したＰＣを使ってダウンロードする必要が

有ります．このＰＣは必ずしもカメラを実際に接続するものと同じで有る必要は有りません．

インターネット接続を利用出来るＰＣがなく，これらのダウンロードが必要となった場合は別途弊社までご相談下さい．

［重要］アプリケーション開発時のＳＤＫ選択について

本製品ではIPエンジンにカナダPleora社のiPORTを採用しています．

iPORTではＳＤＫとして （GenICam API に対応した開発環境／従来の”eBUS-PureGEV Package”に”eBUS-PureGEV Package””eBUS-PureGEV Package””eBUS-PureGEV Package””eBUS-PureGEV Package”

相当）と （GenICam APIには非対応）が利用出来ます．”eBUS-Vision Package””eBUS-Vision Package””eBUS-Vision Package””eBUS-Vision Package”

デモ表示ソフト”Coyote”を含む”eBUS-Vision Package”は以前よりiPORT開発環境として長年使用されて来ましたが，

サードパーティーの画像処理ソフトウエアメーカーや多くのGigEカメラメーカーのカメラ製品でGenICam APIへの対応が

一般的になって来た現在，Pleora社では新規アプリケーションの開発環境としては”eBUS SDK”（GenICam API に対応した開

発環境）の使用を強く推奨しています．

従来よりご開発されて来たiPORTインターフェースやGigEカメラ用のアプリケーションがPleora社の”eBUS-Vision Package”

をプラットフォームとして開発されて来たものであるなど特別の理由が有る場合を除き，新たなユーザーアプリケーション

の開発はGenICam API に対応した開発環境である を用いて頂く事を推奨致します．”eBUS SDK””eBUS SDK””eBUS SDK””eBUS SDK”
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２．ＬＡＮカードのインストールとＯＳの設定

ＬＡＮカードをＰＣに追加して接続する場合には次の手順でＬＡＮカードのインストールを行います．

ここでの説明は Windows 7 の場合を示しています．

（２－１）カードの取り付けとドライバのインストール

①電源を切り，ＰＣのＡＣコードを抜いた状態でＬＡＮカード（intel PRO/1000GT など）をＰＣの内部バスソケットに取り付けます．

②電源を投入すると通常，新しいＬＡＮカードは自動検出されてドライバソフトが自動的にインストールされます．

・intel PRO/1000GT デスクトップ・アダプタで自動的にドライバがインストールされない場合

弊社推奨製品のLAN カード”intel PRO/1000GT デスクトップ・アダプタ”を

組み込んでドライバが自動的にインストールされない場合はカードに添付され

ているドライバディスクを使用してドライバをインストールするか次のURL

（Intelのトップページ）にアクセスし”PRO/1000 GT Desktop Adapter”のキ

ーワードで”Software”を検索し

”Windows 2000, XP, and Server 2003”（XP，Windows7の場合）に対応する

ドライバをダウンロードします．（PRO2KXP_v13_5.exe など）

http://www.intel.com/ (intel社のトップページ)

（注）このドライバソフトはexe形式（実行ファイル形式）である為，

”ハードウエアの更新ウィザード”では検出されません．

更新ウィザードが起動した場合はこれをキャンセルして停止し，上記の

ダウンロードした実行ファイルをダブルクリックしてドライバをインス

ールします．

（２－２）ドライバの確認

スタート → コンピュータ →プロパティ（コンピュータの

アイコンを右クリックして選択）→ システム → デバイス

マネージャー から ”ネットワークアダプター”の項目に

LAN カードに対応するドライバが表示される事を確認しま

す．（右図）

（２－３）ＸＰファイアウォールの設定

OS が Windows XP の場合は次頁以降の

”３．ｉＰＯＲＴソフトウエアのインストール”が完了

した後，以下の手順でホストＰＣ（画像キャプチャー

する側）のファイアーウォール設定を行って下さい．

（注）Windows7 及び Vistaの場合はこの設定変更は必要有りません．

Windows XPの初期設定では添付ソフトウエア（GEVPLayer や Coyote） やSDK を利用して作成したユーザプログラムが扱う特定のネ

ットワークパケットの通信がXP Firewall によって阻止される場合が有ります．

XPのファイアウォールの設定変更でこれらのソフトウエアが扱うパケットの通信を許可しておきます．

①スタート → 設定 → コントロールパネル → Windows ファイアウォール で”Windows ファイアウォール”の設定ウインドウを

表示させます．

②①で例外を処理しないにチェックが入っていない事を確認してから”例外”タブを開き，”プログラムの追加”をクリックします．
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③現れたプログラム追加の一覧から GEVPLayer，Coyote，作成したユーザプログラムをそれぞれ選択して”OK”をクリックし例外の

設定をします．

→設定が完了したら”OK”で”Windows ファイアウォール”のウインドウを閉じます．

（注）Vistaの場合はこの設定変更は必要有りません．

３．ｉＰＯＲＴソフトウエアのインストール

（注）以降の説明ではOS が Windows 7の場合の表示例を示しています．Windows XP の場合はPCで表示される内容は多少異なります．

Windows XP の場合のインストール手順についてはSDK のCD-ROMに同梱されている”GE接続取説（第６版）”をご参照下さい．

ここではｉＰＯＲＴのＩＰドライバ（ｅＢＵＳドライバ）のインストール及びＳＤＫのインストール方法について説明します．

（３－１）ｅＢＵＳ ＳＤＫ のインストール

eBUS SDK をインストールします．この操作でeBUS ドライバ，GEVPLayer（初期のカメラ検索及びＩＰアドレス設定などに使用），

ドライバーインストレーションツール（Driver Installation Tool）その他がインストールされます．

①添付CD-ROMの”SDK”フォルダの中の”eBUS_SDK_2.0.1.1951.exe”をダブルクリックします．

eBUS SDK - InstallShield Wizard が起動します（下図）

（注）Windows XPの場合，インストールの途中で下図の様な警告画面が現れる事が有ります．その場合は”OK”をクリックしてインス

トールを中断し（３－４）の解説を参照して下さい．

②”License Agreement” 画面が表示されるので内容を確認の上”I accept the terms in the license agreement”を選択し”Next”

をクリックします．

インストールするフォルダは特別な事情がない限りデフォルトで表示されるフォルダを指定して下さい．
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③”InstallShield Wizard Completed ”が現れれば eBUS SDK のインストールは終了です．

（３－２）ｅＢＵＳ Ｄｒｉｖｅｒ のインストール

※CD-ROM (Ver.1.4 及びそれ以前）でSDKのインストールと同時にeBUS Driverのインストールが実行されましたがCD-ROM (Ver.2.0)

以降からは SDK のインストールとは別に eBUS Driver のインストールを以下に示す手順で実行する必要が有ります．

サードパーティーサードパーティーサードパーティーサードパーティー製製製製のののの開発環境開発環境開発環境開発環境（（（（例例例例．．．．MatroxMatroxMatroxMatrox のののの MILMILMILMIL，，，， CognexCognexCognexCognex ののののVIsion ProVIsion ProVIsion ProVIsion Pro，，，，National InstrumentsNational InstrumentsNational InstrumentsNational Instruments のののの LabViewLabViewLabViewLabView，，，，（注）

MVTecMVTecMVTecMVTec のののの HALCONHALCONHALCONHALCONなどなどなどなど））））をををを用用用用いていていていてカメラカメラカメラカメラをををを接続接続接続接続するするするする場合場合場合場合はこのはこのはこのはこのeBUS DrivereBUS DrivereBUS DrivereBUS Driverははははインストールインストールインストールインストールしないでしないでしないでしないで下下下下さいさいさいさい．．．．

この様な場合にeBUS Driverをインストールすると正常に画像が取得出来なくなる場合が有ります．

①”eBUS Driver Installation Tool”の起動

すべてのプログラム → Pleora Technologies Inc. → eBUS SDK → Tools → Driver Instllation Tool を選択し起動します．

②”eBUS Driver Installation Tool”のウインドウが現れます．

現在ＰＣに搭載されているLAN カード（またはオンボードLAN コントローラ）の一覧が表示されます

Network Adapter MAC … 各LAN カード（またはコントローラ）のMAC アドレスが表示されます．

Description … 各LAN カード（またはコントローラ）の情報が表示されます．

Current Driver … 現在実装されているドライバが表示されます．

Action … これから実行する作業を指定します．

通常初めてｅＢＵＳドライバをインストールする際は”Current Driver”の欄は”Manufacturer Driver”の状態となっています．

③使用するドライバを選択します．
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eBUS Optimal Driver … intel PRO/1000シリーズLAN カードまたは825xx

シリーズLAN（オンボード）コントローラチップ

を使用している場合に最適なドライバです．

使用使用使用使用ではこのではこのではこのではこのドライバドライバドライバドライバのののの選択選択選択選択をををを推奨致推奨致推奨致推奨致通常のご

しますしますしますします．．．．

eBUS Universal Driver … intel PRO/1000シリーズLANカードまたは825xx

シリーズLAN（オンボード）コントローラチップ

以外のネットワークコントローラを使用している

場合に選択します．ほとんどのLAN コントローラ

で製造元のドライバと協調して高速に動作します．

Manufacturer Driverr … eBUSドライバを使用せず，LANカードオリジナルの

ドライバに戻します．

この状態ではGigEカメラの接続は出来ません．

④ドライバ選択後”eBUS Driver Installation Tool”右下の”Install”ボタンをクリックします．

”Installing”と進捗バーが表示されドライバのインストールが開始されます．

途中で右図の様に”Windows セキュリティ”ウインドウが表示された場合は”Pleora Technologies Inc”からのソフトウエアを常に

信頼する”にチェックマークを入れてインストールを進めて下さい．

（注）ドライバのインストールには数分掛かる場合が有ります．

⑤再起動を促す表示”Reboot Needed”が表示されるので”はい”ボタンをクリックします．

⑥”Current Driver”に選択したドライバがインストールされている事を確認し”CLOSE”ボタンをクリックします．

※GenICam API のみを用いて開発を進める場合 → 第７章 に進んで下さい．”GEVPlayer”GEVPlayer”GEVPlayer”GEVPlayer のののの起動起動起動起動とととと画像画像画像画像キャプチャーキャプチャーキャプチャーキャプチャー””””

M11A06(8/42)
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（３－３）ｅＢＵＳ－Ｖｉｓｉｏｎ Ｐａｃｋａｇｅのインストール

※GenICam API のみを用いて開発を進める場合は以下の内容は跳ばしても構いません．

eBUS-Vision Package をインストールします．この操作でデモ用表示ソフト（Coyote），コードサンプル，ドキュメントなどがイン

ストールされます．

①添付CD-ROMの”SDK”フォルダの中の”eBUS-Vision_Package_4.0.1.1951.exe”をダブルクリックします．

eBUS-Vision Package - InstallShield Wizard が起動します（下図）

②”License Agreement” 画面が表示されるので内容を確認の上”I accept the terms in the license agreement”を選択し”Next”

をクリックします．

インストールするフォルダは特別な事情がない限りデフォルトで表示されるフォルダを指定して下さい．

（次頁に続く→）
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③インストール完了画面が表示されたら”Finish”ボタンをクリックして終了します．

（３－４）iPORT ソフトウエアインストール時の問題への対処 （Windows XPの場合）

OSが Windows XP の場合，インストールの途中で次の様な問題が発生する場合があります．その際には以下に示す対策を取って下さ

い．

［問題］次のエラーメッセージが表示されてインストールが中断してしまう．

・puregev - InstallShield Wizard ”！ Microsoft .NET Framework Version 2.0 was not detected …”

インストールにMicrosoft .NET Framework Version 2.0 以上が必要です．

［対策］”Microsoft .NET Framework Version 2.0”以降をインストールして下さい．

このソフトウエアはマイクロソフトの下記ウェブサイトより入手出来ます．

http://www.microsoft.com/japan/msdn/netframework/downloads/

［問題］次のエラーメッセージが表示されてインストールが中断してしまう．

・Pleora_Eb_App_DIT_32 - InstallShield Wizard ”！ Installation aborted …”

使用中のバージョンの XP にバグが有る為インストールが中断されました．

［対策］Windowsの”Windows Update”機能でホットフィックスを実行して再度インストールし直して下さい．

それでも改善しない場合はXP（SP3）にアップデートして下さい．

XP(SP3)は次のMicrosoftのサイトから入手して下さい．

http://www.microsoft.com/japan/windows/products/windowsXP/sp3/
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４．ツールソフトのインストール

※”eBUS SDK”のビュアーソフトであるGEVPlayerを用いたりこの開発環境で作成したソフトウエアではGenICam APIを通じて設定パラ

メータの確認及び変更が行えますので以下に説明する"FCTool"と”com0com”のインストールは必要有りません．

添付の”eBUS-Vision Package”に含まれるビュアーソフトであるCoyoteを用いてFC-GE カメラの動作設定を行うにはシリアル通信の為

のソフトウエアが必要です．初期設定の為のシリアル通信用ソフトウエアは添付の（または弊社ＨＰよりダウンロードした）FCTool 及

び 添付のGPL ライセンスソフト（フリーソフトウエアの一形態）であるヌルモデムエミュレータソフト”com0com”を使用します．

各ソフトウエアの使用上の注意については各ソフトウエア添付のドキュメントをご参照下さい．

（４－１）FCTool のインストール

インストール方法はソフトウエアに同梱されている説明書「 ＦＣシリーズカメラコントロールソフト”FCTool”のインストール方法

解説 」をご覧ください．

FCTool(Ver.1.00)にはインストーラ機能が省略されている為，添付文書に従って解凍したファイルを適当なフォルダ上に保存して

下さい．

※アンインストールは作成したフォルダごと保存したファイルを全て削除する事で完了します．

（４－２）com0com のインストール（32bit／XP，Windows7）

※64bit／Windoows7へのインストールついては（４－３）項参照．

FC-GE カメラをデモソフトウエア（Coyote）を介してシリアル通信

ソフト（FCToolなど）でコントロールする場合，デモソフトウエア

と通信ソフトウエアはお互いのシリアルポートに対してコマンドを

やり取りする事で実行します．その為にはそれぞれのCOM ポートと

この間を接続するヌルモデムケーブル（送受信線をツイスト接続し

たケーブル）を準備しそれぞれを接続する必要が有ります（Ａ）．

しかし，昨今のＰＣには２つのCOM ポートが実装されていない製品

も多く，またケーブルの準備も必要となり煩雑な問題が生じます．

ヌルモデムエミュレータソフトはこれら２つのCOM ポートとヌル接

続ケーブルをソフトウエア上で仮想的に実現する為のドライバソフ

トウエアです．（Ｂ）

添付ファイル（com0com-2.1.0.0-i386-chk.zip）内の"setup.exe"

を実行してインストールします．

①"setup.exe"をダブルクリックしてインストールを開始します．

②"License Agreement"画面で”I Agree”ボタンをクリックして先に進みます．

Coyote

FCTool

COM1

PC

COM2

Coyote

FCTool

COM5

PC

COM6

（Ａ）

（Ｂ）
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③インストールが進行してコマンドプロンプト画面（黒い画面）が現れると共に下の様な”Windows セキュリティ”ダイアログが現れ，

”ドライバソフトウエアの発行元を検証できません”と表示されます．

→”このドライバーソフトウエアをインストールします”を選択し先に進みます．

（注）インストールの完了までに数分かかる場合が有ります．

ソフトウェアのインストールが進行し，コマンドプロンプト画面は自動的に閉じられます．

インストールが正常に完了すると”Installation Complete”のウインドウが表示されます．

引き続き，”Next >”ボタンをクリックして次の仮想COM ポートの番号の指定に進みます．

（次頁に続く→）
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④先程の”Installation Complete”の画面に続いて”Completing the Null-modem emulator (com0com）Setup Wizard”の画面が現

れます．

引き続き，仮想COM ポートの番号を指定する為，"Launch Setup Command Prompt"にチェックを入れて”Finish”ボタンをクリック

して下さい．（ポート番号の設定は後で行う事も可能です．）

［解説］

”com0com”では２つのポートにデフォルトで CNCA0，CNCB0 という名前が割付けられます．

以下の例では CNCA0 を COM5， CNCB0 を COM6 という名前にリネームする事として説明します．

COM5，COM6 はその他の名称を付ける事も可能ですが，FCTool を使用する場合はこれらの名称はCOM1～COM8の何れか

として下さい．尚，２つのポートに同一の名称や同じＰＣ上で既に割り当てられているポート名を付ける事は出来ません．

⑤コマンドプロンプト画面が表示されます（下図）．

次の様に入力します（下線部）．

command> change CNCA0 PortName=COM5（リターン）

引き続き

command> change CNCB0 PortName=COM6（リターン）

これで２つのポートの名称（この例では COM5，COM6）が割り当てられました．

割り当てが完了すればコマンドプロント画面は右端のクローズボタンをクリックして終了させて下さい．

⑥Windows のデバイスマネージャを起動します．

（スタート → コンピュータ →プロパティ（コンピュータのアイコンで右クリック）→ システム → デバイスマネージャー）

下図の様に com0com - Serial port emulators の項目が表示され（COM5 <-> COM6）などの様に指定したCOM ポート名が表示され

ることを確認して下さい．
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※以上で２つの仮想ポートが定義されました．FCTool と Coyote を用いてカメラの通信制御を行う際には上の例ではFCToolのポート

をCOM5，Coyote のポートをCOM6と指定する事で相互の通信が出来る様になります（COM5，COM6は逆に指定しても良い）．

⑦ポート名の変更など

後でポート名の変更を行う場合などは スタート→全てのプログラム→ com0com → Setup Command Prompt でプロンプト画面を

呼び出しコマンド入力をする事で行います．

→このソフトの詳しい詳しい使用方法などについてはソフトに同梱されている Readme.txt などをご覧ください．

(例) CNCA0 ポートを ”COM5”に変更したが，今度はこれを"COM4"に変更したい．

スタート→全てのプログラム→ com0com → Setup Command Prompt でプロンプト画面を呼び出し次の下線部の様に入力します．

command> change CNCA0 PortName=COM4（リターン）

⑧アンインストール

スタート→全てのプログラム→ com0com → Uninstall で実行出来ます．

（４－３）com0com のインストール（Windows7／64bit版 の場合）

※本プログラムはWindows 7（64bit版）では”テストモード”でのみ動作させる事が出来ます．

添付ファイル（com0com-2.2.1.0-x64-fre.zip）内の"setup.exe"

を実行してインストールします．

インストール手順は 32bit 版と同じなので（４－２）項の手順を参照して下さい．

こうしてインストールされた com0com（64bit対応版）はWindows 7（64bit版）では”テストモード”でのみ実行可能です．

Windows 7 をテストモードにする際には管理者権限でコマンドプロンプトを開き（全てのプログラム → アクセサリ → コマンド

プロンプト（アイコン右クリックで”管理者として起動”））

次のコマンドを入力します．

bcdedit.exe /set TESTSIGNING ON （リターン↓）

この切り替え後にWindowsを再起動する事で com0com （64bit版）

が動作する様になります．

（注）テストモードを解除するには上と同様の手順で

bcdedit.exe /set TESTSIGNING OFF （リターン↓）とします．
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５．カメラの起動と画像キャプチャー

（５－１）カメラの接続

※以下の設定例では右図の様にＬＡＮカードをＰＣのＰＣＩ

スロットに増設しカメラを接続した場合を想定しています．

カメラと電源，ＬＡＮカードをそれぞれのケーブルで接続し

ＰＣの電源を投入します．

（５－２）GEVPLayer によるiPORT エンジンのIPアドレス設定

以下の操作でカメラに内蔵されているiPORT エンジンのIPア

ドレスを設定し，iPORT エンジンからテストパターンを表示

させてカメラとＰＣの接続を確認します．

①スタート→全てのプログラム→ PleoraTechnologies Inc → GEVPlayer で”GEVPLayer”を起動します．

左下左下左下左下にににに配置配置配置配置されているされているされているされている②”Select/Connect”ボタンをクリックして"GEV Device Selection"ダイアログを表示させ，このペインの

．”Show unreachable GigE Vision Device””Show unreachable GigE Vision Device””Show unreachable GigE Vision Device””Show unreachable GigE Vision Device”ににににチェックチェックチェックチェックをををを入入入入れますれますれますれます

※この状態で暫く（最大２０秒程度）接続されたカメラが表示されるのを待ちます．

コンピュータ

LANカード

PU100

電源（PU100など）

FCXXX GE

本機

LANケーブル
（Cat-5e，Cat-6）

Intel PRO/1000

カメラケーブル

Internet接続

オフィス内LAN

オンボードLANポート
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③最初の接続ではカメラのＩＰアドレスが設定されていないので下図の様に赤丸付きの表示で接続したカメラの名称（例．”FC5200GE

…”が表示されます．赤丸付きの表示は現状でIPアドレスが正しく設定されていない事を示しています．

④赤丸付きのカメラの型式表示部分（例：”FC5200GE …”）の表示を右クリックして”Set IP Address”を左クリックします．

GigE Vision Deivice（カメラ）
IPアドレス設定画面

他のデバイスと重複しないIPアドレス
を選択して”OK” をクリックする

赤丸印のラインを右クリック→ ”Set IP Address”を左クリック

赤丸印が消える事を確認する
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⑤”OK”ボタンをクリックして”GEV Device Selection”ダイアログを閉じます．

⑥”GEVPlayer”の”Play”（緑の三角）ボタンをクリックします．

⑥”GEVPlayer”の”Play”（緑の三角）ボタンをクリックします．

下の図の様にカメラから出力されている画像が表示されます．
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（５－３）Coyote による画像キャプチャー

SDK 添付の画像表示デモソフトであるCoyote を用いてカメラ画像をキャプチャーします．

以下の手順の前にカメラとカメラ電源，ＬＡＮカードケーブルは接続しておいて下さい．

①スタート→全てのプログラム→ Plera Technorogies Inc → eBUS Vision Package → Coyote で起動します．

②カメラを接続下図の様に”IP Engine Selection”ダイアログが表示され接続されているカメラのMAC アドレス，IPアドレスが表示

されます．

この”P Engine; MAC …”のラインを左クリックして反転表示させ、”OK”ボタンをクリックします．

③ ”IP Engine Selection”ダイアログが非表示となり，”Coyote”ウインドウにカメラのIPアドレス，MAC，NIC（LAN カード）の

MACなどが表示されます．左下の”Connect”ボタンをクリックしカメラとＰＣのIP接続を開始します．
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④"Connect"ボタンの表示が淡色表示となり，となりの”Disconnect”ボタンの表示が濃色表示に変わります．

この状態でカメラとＰＣがIP接続されています．

⑤以上でカメラとＰＣがIP 接続された状態となりました．

接続が正常に行われているか次の手順で確認して下さい．

Connection（タブ）を選択した状態で IP Engine → Test network connectivity を選択して（下右図）の様に”The IP

Engine is powered and connected to the Ethernet networok.”と表示されれば正常に接続されています．

⑥ライブ画像表示の確認

Acquisition（タブ）を開き”Start”ボタンをクリックするとカメラから出力されている画像が表示されます．

（注）画像が表示されるまで２～３秒程度かかる場合が有ります．

［ライブ画像表示の例］
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（注）カメラの出荷時デフォルト設定ではメニュー表示：ON，出力階調8bitとなっています．

Coyoteを使用している場合はこれらの設定変更は ”６．シリアル通信コマンドによる動作設定”で解説されているシリアル

通信コマンドを用いて行います．

（注）VGA カード（またはＰＣマザーボードのオンボードグラフィック機能）の表示能力が十分でないときにライブ画像が表示出

来ない事があります．この様な場合［Configuration ウインドウの設定］で取り込み階調（Pixel depth）を10bit →8bitと

する事で表示が可能となる場合があります．

取り込み階調を変更した際はカメラブロック側の画像出力階調を10bit（デフォルト）→8bitに変更する必要です．出力階調

の変更方法は以降の”シリアルコマンドによる設定変更”の項目をご参照下さい．

（注）ライブ表示画像で縮小表示した際，表示倍率によっては薄い縦縞状のパターンノイズが見られる場合が有ります．

［解説］Coyote ライブ表示画面の操作

●右クリックメニューでの操作

Coyoteのライブ表示画面は右図の様に表示画像上でマウスを右クリック するとメニュー

が表示されます．

Zoom Fit … モニター表示画面にフィットするサイズで画像表示されます．

Zoom 1:1 … モニター画面の１画素に対してカメラの１画素が対応して表示されます．

Zoom Out … 選択する度に表示がズームアウト（縮小表示）されます．

Zoom In … 選択する度に表示がズームイン（拡大表示）されます．

Zoom User … 数値で指定した表示倍率に設定します．

Recenter … 画像のセンターをモニター表示センターからずらせた後，再びセンターに合わせ

る際に選択します．

Lock on center … チェックが入っていると画像のセンターが常にモニター表示のセンター

に固定した状態で表示されます．（デフォルトでチェックが入っています）

Reize window … 画像表示サイズを拡大または縮小した際に倍率変更前の画像が重なって

表示される事が有ります．この際にこれを選択すると重複表示が解消されます．

Backfround … 表示ウインドウの背景色を指定します，

Properties … 現在ライブ表示されている画像のフレームレート，表示倍率などの情報

が表示されます．

●マウススでの操作

マウスホイール … 表示ウインドウ上にマウスポインタを置きホイルを前後に回転させることでズームイン，アウトが出来

ます．

ドラッグ操作 … 上の”Lock on center”が解除されている状態で画像上にマウスポインタを置きドラッグ（左ボタンを

押しながらマウスを動かす）事で画像表示位置をずらせる事が出来ます．

※ライブ表示の終了にはライブ表示ウインドウ右上”Ｘ”ボタンをクリックします．
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⑦iPORT I/F のコンフィギュア（動作定義）

本製品はカメラブロック部＋GigEインターフェース（iPORT I/F）

で構成されています．

・カメラ部分のパラメータ設定

Coyoteの通信機能を用いたシリアル通信コマンドで行います．

→本説明書 ”６．シリアル通信コマンドによる動作設定”及び

別紙の”カメラ取扱説明書”の”シリアル通信制御”の各説明

を参照して下さい．

・GigEインターフェース（iPORT I/F）の設定

Coyoteでは”Configuration”ダイアログで行います．

下図の通りメインウインドウの”Configure”ボタンをクリックすると”Configuration”ダイアログが表示されます．

●設定例（１） 画像階調の変更

本製品の出荷時デフォルトの状態では画像出力階調は白黒／カラーの製品ともに8bit階調に設定されています．

この画像階調を他の階調（10bit／12bit）に変更する場合は，シリアルコマンドを用いた設定でカメラヘッド側の出力階調を変更

するとともに，iPORT I/F 側のｺﾝﾌｨｷﾞｭｱ（設定）をこれに合わせて変更する必要が有ります．

”Configuration”ダイアログの"Pixel"タブを選択します．画像階調は”Pixel depth”のプルダウンメニューから 8bit/10bit

/12bitなどの階調から選択します．

選択出来る階調はカメラの機種によって異なりますので別途”カメラ取扱説明書”を参照して下さい．

（注）Coyoteで画像階調設定を変更する前にカメラヘッド側の画像出力階調を対応する階調（8bit/10bit/12bit）に変更しておく必

要が有ります．→ ”６．シリアル通信コマンドによる動作設定”を参照して下さい．

DATA（12／10/8bit)
RJ-45 コネクタ

GigE I/F

iPORT

SYNC
（FVAL，LVAL，CLK）

SERTC
SERTFG

CAMERA BLOCK

[Pixel タブ] ”Pixel depth"

”Configuration”ダイアログの表示
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●設定例（２） リクエストタイムアウト（Request Timeout）の設定

カメラから送られて来る画像フレームデータをホストＰＣが待ち受ける最大時間を規定します．

Coyoteのデフォルト値は”5000”（ms）となっています．

このタイムアウト値を越えた画像データは不正画像（Invalid Image）と認識されて正常な画像取り込みが出来ません．

デフォルト値は”5000”（ms）は通常，カメラを連続シャッタ動作またはシャッタなしの状態で使用する場合は十分な長さですが，

カメラをランダムシャッタ動作で使用し，且つトリガ間隔が５秒を越える様な場合はタイムアウトの発生で正常な画像取り込みが

出来ない場合が有ります．

従って，カメラをランダムシャッタ動作や５秒を越える長時間露光動作で使用する場合はこの設定値を十分大きな値に変更して下

さい．

特にカメラをランダムシャッタ動作で使用してトリガ信号の間隔が不定の場合は数値（4294967295=0xffffffff）を設定する事によ

りタイムアウト（画像待ち受け時間）が無限大となりランダムシャッタ動作でカメラブロックから長時間画像データが出力されな

い状態でも invalid data （不正な画像データ）が発生しません．

５秒を越える長時間露光動作時はその露光時間より長い値を指定して下さい．

●設定例（３） ＲＧＢフィルタ （RGB Filter）の設定

Bayer RGB カメラ（FS5200GEなど）を接続し Coyote で画像取り込みを行う際，R/G/B色バランス（ホワイトバランス）をとる為

に，RGB各レベルの倍率とオフセットレベルの設定を行う事が出来ます．

（注）”RGB Filter”の設定値により画素毎のデータには次の様な補正が掛かります．

補正後のデータ数値 = 補正前の数値 × Gain ＋ Offset

[RGB Filter タブ]

[IP Engine タブ] ”Request timeout”
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（注）Configuration ウインドウのタイトルバーで ”Configuration - Basic”と表示されているときは”RGB Filter タブ”が

表示されません．ウインドウ左下の”Show advanced configuration pages”のチェックボックスにチェックを入れ

”Configuration - Advanced”と表示される状態にして下さい．

●設定例（４）３×３画素ベイヤ補間（3x3 Bayer Interpolation）の使用

Bayer RGB カメラ（FS5200GEなど）を接続し Coyote で画像取り込みを行う際，デフォルトの２×２画素ベイヤ補間に代えて３×

３画素ベイヤ補間を選択する事が出来ます．この補間方法と選択すると斜め線や対象物体のエッジ部でのギザつきや偽色の発生が

抑えられます．但し，補間処理の為に時間が割かれホストＰＣの処理速度が低下します．

※コンフィギュア（値の定義）が完了したら”Configure”ウインドウの中央下の”OK”をクリックしてこのウインドウを閉じます．

[Pixel タブ] ”Use 3x3 Bayer Interpolation”
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⑧コンフィギュレーション内容を設定ファイルに保存します．

⑦で設定したコンフィギュレーションの内容を次回の起動時以降に利用する為に設定ファイルとして保存する事が出来ます．

File → Save As... と進み（下図）保存先の適当なフォルダ名とファイル名を指定して保存します．

※ファイル名の拡張子は”.xml”です．省略して保存を押すと自動的に”.xml”の拡張子が付けられて保存されます．

（５－４）設定ファイルを用いたCoyoteの起動

（５－１）～（５－３）に示した手順でCoyoteが正常に起動出来た場合，２回目以降の起動はCoyoteから設定ファイルを開く事で簡

単に起動出来る様になります．

①スタート→全てのプログラム→ Pleora Technorogies Inc → eBUS Vision Package → Coyote で起動します．
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②File → Open と進み左クリックします．

③保存されている設定ファイル（xmlファイル）を選択し”開く”ボタンをクリックします．

④自動的に"Connect"ボタンの表示が淡色表示となり，となりの”Disconnect”ボタンの表示が濃色表示に変わります．

この状態でカメラとＰＣがIP接続されています．

（注）カメラの起動直後などで接続が未完了で”Error=CY_RESULT_TIMEOUT(30)”のエラーが表示された場合は”DETECT”から

”IP Engine Selection”ウインドウを表示させて接続されているカメラの選択後”Cconnect”（クリック）して接続を待ち

⑤に進みます．

⑤”Coyote”ウインドウから Acquisition（タブ）を開き”Start”ボタンをクリックします．

ＰＣモニター上に別カメラで撮影している画像がライブ表示される事を確認します．

※これ以降の操作は前項（５－３）⑥以降と同じです．”Configure”の内容を変更しない場合は設定ファイルを再度保存する必要は

有りません．設定内容を変更した場合（例えば画像の階調を10bit→8bitに変更したなど）は設定ファイルの”Save As...”で別名

保存することにより使用状況によって起動時にオープンするファイルを選択して必要な設定状態（例えば10bit／8bit）から起動出

来る様になります．
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（５－５）設定ファイルを用いたCoyoteの起動（その２～設定ファイル作成時と別のカメラ）

設定ファイルを作成したカメラと別のカメラ（同一機種でシリアル番号の異なるもの）を接続してCoyoteを起動させる場合は次の手

順で行って下さい．

この手順は同一の前回接続していたカメラと同じカメラでIPアドレスが変更された場合にも適用されます．

①スタート→全てのプログラム→ Plera Technorogies Inc → eBUS Vision Package → Coyote で起動します．

②File → Open と進み左クリックします．

③保存されている設定ファイル（xmlファイル）を選択し”開く”ボタンをクリックします．

※ここまでは（５－４）と同じです．

④次の様に”Error = CY_RESULT_NETWORK_ERROR(19)”または”Error = CY_RESULT_TIMEOUT(30)”とエラーのメッセージウインドウ

が表示されます．

”OK”ボタンをクリックしてこのウインドウを閉じます．

（注）これは設定ファイル（xmlファイル）に保存されているMACアドレスやIPアドレスが実際に接続されているカメラと異なる為

に発生するエラーです．

⑤ Connection（タブ）の”Detect”をクリックします．

⑥新しく接続されたカメラが検出され，それに対応するMAC アドレスとIPアドレスが表示されます．

これを選択して反転表示させ"OK"をクリックします．
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⑦Connection（タブ）に新しいMAC アドレスとIPアドレスが表示されている事を確認して”Connect”ボタンをクリックします．

⑧”Coyote”ウインドウから Acquisition（タブ）を開き”Start”ボタンをクリックします．

ＰＣモニター上に別カメラで撮影している画像がライブ表示される事を確認します．

※これ以降の操作は前項（５－３）⑥以降と同じです．

⑨コンフィギュレーション内容を設定ファイルに保存します．

新たに接続されたカメラのMAC アドレスとIPアドレスに対応した設定ファイルとして保存する事が出来ます．

File → Save As... と進み保存先の適当なフォルダ名とファイル名（先程と別名ファイル）を指定して保存します．

※２回目以降の起動では新たに作成した定義ファイル（xmlファイル）を開く事で簡単にCoyoteが起動出来ます．

→（５－４）項を参照．

（５－６）Coyote のその他の機能

Coyote にはライブ画像表示機能の他，画像イメージの保存機能（Image Saving），画像データ診断機能（Diagnostic）など有用な

諸機能が備えられています．

これらの機能を含むCoyote の詳しい取扱方法については スタート→全てのプログラム→ Plera Technorogies Inc → eBUS Vision

Package → Documentation からCoyote を参照して下さい．

※文書の閲覧にはPDF フォーマットの文書が読み出せるソフトウエア（Adobe社／PDF Reader など）が必要です．

※添付のSDK にはCoyote のソースコードが同梱されています．
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６．シリアル通信コマンドによる動作設定

※GenICam APIを用いた開発環境（eBUS SDK）でソフトウエアを開発する場合はこのシリアル通信コマンドでの設定は必要ありません．

本シリーズカメラはシリアル通信ソフトウエアを用いてカメラの動作設定パラメータを変更する事が出来ます．

シリアル通信ソフトウエアには別冊のビデオカメラ取扱説明書の中の”シリアル通信制御”に説明されている内容の通信プロトコルに

従うもので有ればどの様なものでも使用可能です．

以下の説明では弊社が無償配布しておりますＦＣカメラ評価用通信ソフトウエアである を使用して動作設定を行う方法を中”FCTool””FCTool””FCTool””FCTool”

心に説明しています．

（６－１）シリアル通信ポートの準備

”４．ツールソフトのインストール”で解説されている通り，添付のＳＤＫ（Coyoteなど）を用いてカメラと通信を行うには物理的

な２つのポート（”COM1”と”COM2”）とヌルケーブル（TXD，RXDをツイスト接続したケーブル）を準備するか，ヌルモデムエミュ

レータソフト（添付の など）を使用するＰＣにインストールしておく必要が有ります．com0comcom0comcom0comcom0com

以下の説明ではヌルモデムエミュレータソフトを用いて２つのポートCOM5，COM6が使用出来る状態であると仮定しています．

→ ”４．ツールソフトのインストール”を参照．

（６－２）FCToolのインストール

以下の説明ではFCTool(Ver.1.00以上)が”c:\Program Files\FCtool”のフォルダにインストールされているものとします．

→ FCToolに同梱されている「ＦＣシリーズカメラコントロールソフト”FCTool”のインストール方法解説」をご覧ください．

（６－３）シリアル通信の開始

①５項の解説に従ってCoyoteを起動します．

②Coyoteのメニューバーから IP Engine → Serial COM Port Link... と進み”Serial Port Configuration”のダイアログボックス

を表示させます．

（注）”Serial Port Configuration”はカメラが正常に接続された状態（上図のウインドウで”Connect”が淡色表示されている）で

ないと表示させる事が出来ません．
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③”Serial Port Configuration”ダイアログボックスで”Port”の横の矢印ボタンを押してポート番号一覧を表示させ，通信に使用す

るポート（ここでは COM6 ）を選び"OK"をクリックします．

※これでCoyote は”COM6”ポートを使ってシリアル通信を開始する準備が出来ました．

（（（（注注注注））））CoyoteCoyoteCoyoteCoyote ででででシリアルコマンドシリアルコマンドシリアルコマンドシリアルコマンドをををを用用用用いるいるいるいる際際際際，，，，CoyoteCoyoteCoyoteCoyote 起動時起動時起動時起動時にににに②②②②～～～～③③③③のののの手順手順手順手順をををを毎回実行毎回実行毎回実行毎回実行するするするする必要必要必要必要がががが有有有有りますりますりますります．．．．

④FCTool を起動します． （FCTool.exeが保管されているフォルダを開きFCTool.exeをダブルクリックします．）

初回の起動では”Please configure port settings.”とダイアログが表示されます．

ここでは”OK”をクリックして”FCTool (COM port settings)”を表示させ，”PORT”で”COM5”を選択します．

（注）こでは Coyote のポート番号と異なる”COM5”を選択する事に注意して下さい．以上の手順でFCTool のポート"COM5" と

Coyote のポート ”COM6”が仮想的なヌルモデムケーブルを用いてクロス接続された状態となります．

（注）FCtool では”FCTool (COM port settings)”の内容が記憶される為，ポート番号（PORT），ボーレート（BPS）の設定内容はこ

れらを変更するまで再設定する必要は有りません．

⑤引き続き”FCTool (COM port settings)”で”OK”をクリックするとFCTool が起動します．

※下図の様にFCTool を起動した際に”No camera found!”とエラー表示出る際はCoyote 側のポート番号の設定（この例では COM6）

とFCtool 側のポート番号の設定（この例では COM5）が正しいか再度確認して下さい．
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⑥FCTool が正しくカメラと通信しているかを確認する為にカメラのバージョンリポートを確かめましょう．

”FCTool (Direct command)”の上側の入力枠に”RV”と入力し”SEND”ボタンをクリックするかリターンキーを押します．

※正常に通信出来ている場合は下図の様に”FCTool (Direct command)”の下側枠に”RTakenaka SYS …”とカメラの型式とバージョ

ンコードが表示されます．

仮想仮想仮想仮想ポートポートポートポート番号番号番号番号のののの名前名前名前名前（（（（”COM”COM”COM”COM5555””””，，，，""""COMCOMCOMCOM6666""""などなどなどなど））））にににに誤誤誤誤りがりがりがりが無無無無いかいかいかいか ヌルモデムエミュレータソフトヌルモデムエミュレータソフトヌルモデムエミュレータソフトヌルモデムエミュレータソフトがががが正正正正※正しく通信出来ない場合は ，

などを確認して下さい．しくしくしくしくインストールインストールインストールインストールされているかされているかされているかされているか

ヌルモデムエミュレータソフトが正常にインストールされているかどうかはウィンドウズのデバイスマネージャから確認する事が

出来ます．

→詳しくは”４．ツールソフトのインストール”の項目をご参照下さい．

※手順②～③のCoyote のシリアル通信ポートの設定はCoyote の設定ファイル（xmlファイル）に保存させる事が出来ない為Coyote

を起動させる度に毎回実行する必要が有ります．

（６－４）シリアル通信による設定例

以下の説明ではFCToolを用いてカメラのゲイン設定，出力画像階調の切り替えなど実際に設定パラメータを変更する例を示します．

・ＭＧＣゲインの設定

FCTool の MGC スライドバーを操作して変更する事が出来ます．（下図）

また，”FCTool (Direct command)”を用いてカメラの”Ｇ”コマンドを直接入力し設定する事も可能です．

例えば設定値を”90”（=H'5A）にする場合はダイレクトコマンドの入力枠に”G5A....”と入力して送信します．（下図）

・露光時間（シャッタ時間）の設定

露光時間の設定には幾つかの方法が有ります．ここでは”外部設定のプリセット値設定”で行う方法を説明します．

→詳しくは別冊のビデオカメラ取扱説明書とFCToolの取扱説明書（FCToolの配布ファイルに同梱）をご参照下さい．

FCToolの”COMPACT 表示領域の露光時間設定変更ブロック”の部分で操作します．下の図はシャッタプリセット値を”7”とした場

合の例です．

（注）プリセット値に対応するシャッタ値（VALUE）はカメラの種類やシャッタテーブルの設定内容などにより異なります．

EXTのチェックボックスをCHECKして下の
＋／－ボタンでスイッチのポジションを決定
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・OSD メニュー表示の ON/OFF 設定

FCToolの”MENU OFF”（ON→OFF）または”MENU ON”ボタンをクリックします．

・画像出力階調の設定

画像の出力階調はカメラのコンフィギュレーションレジスタ（CR）の設定値を変更する事で変更する事が出来ます．

FCToolを使ってこの変更を行う際は次の様にコンフィギュレーションフラグの書き換えを行います．

FCToolのメニューバーから Tools → Edit Flags → CR Flags と進み下のCRフラグ編集画面を出します．

例えば ではCR(4)とCR(3)で出力階調が決定され CR(4）=0，CR(3)=0 の時は10bit階調，CR(4）=0，CR(3)=1の時は8bit階FC5200GEFC5200GEFC5200GEFC5200GE

調，CR(4）=1，CR(3)=0の時は120bit階調となります．

下の例ではCR(4）=0，CR(3)=1として8bit階調出力に設定する際の（CR）フラグ設定例です．第３ビットにチェックを追加して

”WRITE”ボタンをクリックします．

（注）上記の操作だけではカメラの内部不揮発性ROM への保存は実行されません．電源ＯＦＦ後も設定が保存される様にするには

この操作の後で”コンフィギュレーション項目のセーブ”操作が必要です．（後述→”・設定内容の保存”）

（注）階調の設定がiPORTのコンフィギュア（→（５－３）項参照）で設定した”Pixel depth”値と一致していない状態で画像

キャプチャーすると（下図左）の様な異常な画像となります（画像が表示されなくなる場合も有ります）．

FCToolでカメラの出力画像階調を変更した際にはiPORT 側のコンフィギュア（Pixel depth）を忘れず変更して下さい．

階調設定誤りの画像例 階調設定誤り修正後
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・設定内容の保存

シリアルシリアルシリアルシリアル通信通信通信通信コマンドコマンドコマンドコマンドをををを使用使用使用使用してしてしてして設定設定設定設定したしたしたした内容内容内容内容ははははセーブセーブセーブセーブ（（（（カメラカメラカメラカメラ内部内部内部内部のののの不揮発性不揮発性不揮発性不揮発性ROMROMROMROM へのへのへのへの書書書書きききき込込込込みみみみ））））操作操作操作操作をををを実行実行実行実行しないとしないとしないとしないとカメラカメラカメラカメラのののの

．電源電源電源電源ＯＦＦＯＦＦＯＦＦＯＦＦとととと共共共共にににに消失消失消失消失してしまいますしてしまいますしてしまいますしてしまいます

設定内容の保存方法は設定項目が”プログラムページ項目”か”コンフィギュレーション項目”かの何れかによって異なります．

設定項目が何れに該当するかは別冊のビデオカメラ取扱説明書をご参照下さい．

［プログラムページ項目のセーブ］

MGC 設定値や連続シャッタ（NRML）／ランダムシャッタ（ASYNC）の設定などのプログラムページ項目はFCToolを”FULL”表示にし

て”Program Page”の”SAVE”側のドロップダウンリストからセーブしたいプログラムページ（A～F）を選び”SAVE”ボタンをク

リックします．

※ダイレクトコマンド入力でこれと同じ動作をさせるには”WA”（Aページにセーブの場合）～”WF”（Fページにセーブの場合）

と入力しコマンドを送信します．（上図右）

［コンフィギュレーション項目のセーブ］

OSD メニューの ON/OFF 設定や画像データ出力階調の切り替えなどのコンフィギュレーションレジスタ（CR）での切り替え項目と

それ以外のコンフィギュレーション項目（IDデータやVSUB設定値など）はそれぞれの設定項目に対応したコマンドをダイレクト入

力する事で実行します．

（例）VSUBデータの設定値 → ダイレクトコマンド入力で”SVSUB”コマンドを送信する事で保存出来ます．

但し，コンフィギュレーションフラグ（CR）の内容とID（ユーザが設定したカメラID情報）の内容はFCToolのメニューバーから

Tools → Save → Configuration Flags または CAM ID でもセーブする事が出来ます．

［解説］FCToolのダイレクトコマンドによる設定と専用コマンドボタンによる設定

カメラの動作設定は全て”STX”（=H'02）と"ETX"（=H'03）の間に定義された文字列（アスキーコード）を挿入して送信する

事で実行出来ます．従って，ダイレクトコマンドウインドウを使って規定された文字列を送信する事で定義された全ての制御

が可能です．

FCToolでは頻繁に使用されるコマンドを簡単に操作する事が出来るように例えばMGC 設定値はスライドバーを使っ変更出来る

様にしたり，”MENU ON (OFF)”ボタンの様にワンクリックで動作切り替えが出来る様に，規定された一連の文字列を自動で

送信して簡単に操作出来る様にしています．

ダイレクトコマンド入力では”WA”
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GEVPlayer の起動と画像キャプチャー７．

ここでは添付のＳＤＫ ”eBUS-PureGEV Package”に同梱されている画像表示ソフトウエアGEVPlayerを用いた画像表示方法について説

明します．

（７－１）GEVPlayer とCoyote の違いについて

GEVPlayerは に対応した画像表ソフトウエアです．このソフトウエアを用いると外部のシリアル通信ソフトウエアを用いGenICam APIGenICam APIGenICam APIGenICam API

ずに各設定パラメータ（GenICamフィーチャー）をカメラ内部の設定レジスタに直接アクセスして変更する事が出来ます．

Coyoteが含まれるＳＤＫ”eBUS-Vision Package”とシリアル通信ソフトウエアを用いたソフトウエア開発ではカメラ側で規定されて

いるカメラ固有のシリアル通信コマンドの内容を理解しそのカメラ専用のソフトウエアを設計しなければなりませんが，GEVPlayerが

含まれるＳＤＫ”eBUS SDK”を用いて開発したソフトウエアはGenICam APIを使用して他の機種や他のメーカーの製品，インターフェ

ース方式のカメラにも応用出来るものとなります．

［用語］ （ジェニカム）GenICamGenICamGenICamGenICam

EMVA （European Machine Vision Association）が制定した規格．

異なるインターフェース方式（IEEE1394，CameraLink，GigE Vision など）のカメラを共通の APIで制御する目的で策定さ

れました．

アプリケーション開発者にとってはカメラのインターフェースに拘らず横断的なソフトウエア開発が可能となるメリットが

有ります．

（７－２）GEVPlayerの起動と終了

①スタート→全てのプログラム→ PleoraTechnologies Inc → eBUS SDK → GEVPlayer で”GEVPLayer”を起動します．

②”Select/Connect”ボタン→"GEV Device Selection"ダイアログで，接続されているカメラを選択し”OK”をクリックします．

（注）初回の接続でカメラのIPアドレスが設定されていない時

→”（５－２）GEVPLayer によるiPORT エンジンのIPアドレス設定”の説明を参照して下さい．

（注）”Select/Connect”ボタンをクリックしてカメラが検出されるまで20～30秒程度掛かる場合があります．
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③”GEVPlayer”の”Play”（緑の三角）ボタンをクリックし表示をスタートさせます．

④”STOP”ボタンをクリックし表示を停止します．必要で有れば次回の起動に備えて”GEVPlayer”上で変更した設定を保存します．

※次回の起動時この設定ファイル（.pvcfg ﾌｧｲﾙ）を開く事により設定した内容が反映されて起動しますので起動が容易になります．

⑤”Disconnect”ボタンをクリックしてイーサネットとの接続を断ちます．

（注）”Disconnect”で接続を断ってからカメラの電源をOFF として下さい．先にカメラの電源を切るとソフトウエアがハングア

ップする場合が有ります．

この様な理由でソフトウエアがハングアップしてしまった場合はＰＣ側で［Ctrl+Alt+Delete]キーの操作でウインドウズのタ

スクマネージャを起動しGEVPlayerを強制終了して下さい．
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（７－３）GenICam フィーチャー（パラメータ）の設定

GenICam規格で規定されている各フィーチャーは次項で説明する”コントロールダイアログ”で設定，または設定値の確認を行います．

GEVPlayerで変更した各フィーチャー（パラメータ）はCoyoteで必要で有った様な外部のシリアル通信ソフトウエアを使用しなくても

必要に応じてGEVPlayerに備わった通信機能（カメラ内部の設定XMLファイルの読み書き機能）で自動的にカメラヘッド部まで伝えら

れ適用されます．

GenICamフィーチャーの呼称や機能についてはEMVA（European Machine Vision Association）が作成した規格（Standard Features

Naming Convention Version 1.1）に準拠しています．

（７－４）コントロールダイアログ

GEVPlayer のメイン画面左下側に ”Parameters and Controls”が配置されており次の３つのダイアログが有ります．

”Communication Control” … ネットワークのトランスポートレイヤ上の設定を行います．

※GEVPlayer側の設定内容である為，カメラを接続していない状態での表示及び設定が可能です．

”GEV Device Control” … カメラ内部のIP エンジン（iPORT）とカメラブロックのパラメータ設定を行います．

※カメラとの接続完了後の表示及び設定が可能です．

”Image Stream Control” … カメラ～ホストＰＣ間のストリーム（画像データ伝送）制御や統計表示（データ伝送状態の表示）

を行います．

※カメラとの接続完了後の表示及び設定が可能です．

（７－５）コントロールダイアログの表示について

・Visibility … 表示の可視性の設定を行います．

普段良く設定内容を変更する頻度が高い，低いの内容によってから

パラメータ表示の可視性が決められています．

この”Visibility”は次の３段階が有ります．

この設定は”Beginner”→”Expert”→”GURU”となるに従ってよ

り表示項目数は増え”GURU”では全てのパラメータが表示されます．

操作頻度の高くないパラメータを表示させたくない場合は

”Beginner”など可視性を低く設定する事でパラメータの選択表示

が容易となります．

Beginner … 普段設定変更を行う頻度が高く，基本的な設定項目だ

けが表示されます．

Expert … やや高度な設定で，それ程使用頻度が高くない項目ま

で表示されます．

GURU … 高度な設定項目を含め全ての項目が表示されます．

・淡色表示と濃色表示 … リードオンリー（表示だけ可能）のフィーチャーや現在の状態（ストリーミング表示中など）では設定変

更出来ない項目は淡色表示，設定変更可能な項目は濃色表示されます．

・設定項目の種類 … 数値で指定するもの，列挙された候補から選択するもの，コマンド入力を行うもの，文字列を入力するも

のなどが有ります．

数値の設定値は上・下限値やインクリメント単位（１ずつの増減，２ずつの増減など）が規定されている

ものが有ります．

（７－６）設定変更の例

ここではコントロールダイアログの”GEV Device Control”を用いて種々の設定変更を行う例を示します．

（例１）OSDメニュー表示のON/OFF

FC-GE シリーズカメラは標準出荷状態でOSDメニュー表示がONとなっています．

メニュー表示をOFFに切り替える方法を示します．

・TakexCameraControlS > OSDMenu > FCMenu の項目を選択します．

→ ”Off”（非表示）を選択しリターンキーを押します．

（注）画像ストリーミング出力中（画像表示中）に選択項目表示が濃色

表示で示されている場合は原則的に画像表示を実行させながら

パラメータ値を変更しカメラに反映させる事が可能ですが，使用

しているＰＣのパフォーマンスによってストリーミングが途切れ

たり表示動作が不安定になったりする場合が有ります．

この様な場合は”STOP”（赤色ボタン）をクリックして表示を停

止してから設定変更を行って下さい．

（注）変更されたOSDメニュー表示のON/OFF状態の設定はこのままでは

カメラ電源の OFF とともに失われます．

次回以降の電源起動時にもこの設定を有効とするにはこのダイア
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ログウインドウ上部の Visibility の設定を Expert （または

GURU ）に変更し，

TakexCameraControlS > SaveAndLoad > FcSaveCFG のコマンド

をクリックします．

また後述の”（例７）設定の保存”で保存する事も出来ます．

（例２）MGCゲインの設定

カメラのMGCゲイン設定の変更を行う例を示します．

・AnalogControl > GainRaw の項目を選択し数値を入力します．

FC-GEシリーズでは数値の範囲は 0～255 です．直接数値を入力するか

入力欄右側の上下矢印をクリックすると１ずつの増減が可能です．

→数値を変更した後にリターンキーを押すか，他の項目に選択を移すか

する事により設定値がカメラに反映されます．

（注）変更されたMGCゲイン設定値はこのままではカメラ電源の OFF と

ともに失われます．

次回以降の電源起動時にもこの設定を有効とするには

TakexCameraControlS > SaveAndLoad > FcPageSelector

で”PageA”を選択した後，

TakexCameraControlS > SaveAndLoad > FcSavePage のコマンド

をクリックします．

※PageAに記憶された設定値は電源起動時に読み込まれ動作パラ

メータに適用されます．

また後述の”（例７）設定の保存”で保存する事も出来ます．

（例３）露光時間の設定－連続シャッタ－直接シャッタ時間指定

連続シャッタモードでシャッタ露光時間の直接指定（例.1000）を行う例を示します．

次の一連のパラメータを設定します．

①AcquisitionAndTriggerCntrols > ExposureMode の項目で設定を”Timed”とします．

②AcquisitionAndTriggerCntrols > PresetShutter の項目で設定を”ExposureTime”とします．

③AcquisitionAndTriggerCntrols > ExposureTimeRaw の項目で設定を”1000”を入力しリターンキーを押します．

（例４）露光時間の設定－ランダムシャッタ－プリセット値指定

ランダムシャッタモードでシャッタ露光時間をプリセット５に設定する例を示します．

次の一連のパラメータを設定します．

①AcquisitionAndTriggerCntrols > ExposureMode の項目で設定を”TriggerControlled”とします．

②AcquisitionAndTriggerCntrols > PresetShutter の項目で設定を”Preset5”を選択しリターンキーを押します．
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（例５）露光時間の設定－連続シャッタ－絶対時間（ms単位）指定

連続シャッタモードでシャッタ露光時間をμs単位で指定し設定する方法（例．40000μs=40ms）を示します．

次の一連のパラメータを設定します．

①AcquisitionAndTriggerCntrols > ExposureMode の項目で設定を”Timed”とします．

②AcquisitionAndTriggerCntrols > PresetShutter の項目で設定を”ExposureTime”と

します．

③AcquisitionAndTriggerCntrols > ExposureTimeAbs の項目で設定を”40000”を入力

しリターンキーを押します．

（注）右図はFC5200GEで数値”40000”を設定し入力した際の例です．

数値”40000”に対して実際にカメラへの設定可能な値として”39999.3”μｓが

反映されています．

これはカメラ側でシャッタ時間がＨ（水平同期時間）単位で設定される為です．

→この値”40000”μsに呼応して”ExposureTimeRaw”の値が”814”になっている事

が解ります．即ち，設定値”40000”μsに最も近いＨ数にあたる”814”がカメラに

セットされます．

（例６）画像出力階調の設定

画像出力階調を8bit（デフォルト）→10bit に切り替える方法を示します．

・ImageSizeControl > PixelFormat で”mono10”（カラーの場合”Bayer RG10”）

を選択しリターンキーを押します．

（例７）設定の保存

パラメータの設定を保存し，次回電源投入時に設定内容が反映される様にします．

次の手順で行います．

①UserSets > UserSetSelector で"UserSet1"を選択します．

②UserSets > UserSetSave のコマンドボタンをクリックします．

③UserSets > UserSetDefaultSelector で”UserSet1”を選択しリターンキーを押します．

※これで設定内容がカメラ内部のXMLファイルに保存され，設定内容が次回の電源起動時に適用されます．

（例８）デフォルト設定のリストア（デフォルト設定の再ロード）

諸パラメータの設定をデフォルト値に戻します．

①UserSets > UserSetDefaultSelector で”UserSet1”を選択しリターンキーを押します．

②”Disconnect”ボタンをクリックして接続を断ちます．

※これで次回の電源投入時にカメラはデフォルト状態で起動します．

→再起動後，設定内容を”UserSet1”に設定保存後 ”UserSetDefaultSelector”を”UserSet1”に戻します．

（注）”UserSetDefaultSelector”が”Default”に設定されている状態では起動時の設定が常にデフォルト設定となります．

（７－７）その他の設定パラメータ

その他の設定パラメータ（フィーチャー）の詳細についてはカメラに添付されている”カメラ取扱説明書”をご参照下さい．
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（７－８）GEVPlayer のImage Filtering 機能

●ホワイトバランス

BayerRGB 出力型のカメラ（FS5200GEなど）のキャプチャー画像で白バランス（ホワイトバランス）を調整する事が可能です．

メインウインドウから Tools → Image Filtering を選択し”Image Filtering”パネルを表示させます．

→カメラで白紙などを撮像させた状態で”White Balance”ボタンをクリックする事で白バランスを取る事が出来ます．

また，スライダでR/G/Bの比率やオフセットで手動バランスをとる事も出来ます．

●３×３画素ベイヤ補間（3x3 Bayer Interpolation）の使用

Bayer RGB カメラ（FS5200GEなど）を接続し Coyote で画像取り込みを行う際，デフォルトの２×２画素ベイヤ補間に代えて３×

３画素ベイヤ補間を選択する事が出来ます．この補間方法を選択すると斜め線や対象物体のエッジ部でのギザつきや偽色の発生が

抑えられます．但し，補間処理の為に時間が割かれホストＰＣの処理速度が低下します．

”Image Filtering”パネル上の”Bayer Interpolation”から ”3x3 Interpolation”を選択します．
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８．添付ＳＤＫとドキュメント

製品にはＳＤＫとして”eBUS SDK”（注↓)並びに”eBUS-Vision Package”が添付されています．

”eBUS SDK”では GenICam API を採用して進める開発環境，”eBUS-Vision Package”では GenICam API を使用しないで進めるソフト

ウエア開発環境が提供されます．

（注）従来のバージョン（CD-ROMﾊﾞｰｼﾞｮﾝ Ver.1.4 及びそれ以前）では”eBUS SDK”は”eBUS-PureGEV Package”と呼称されていまし

たが現在のバージョン（CD-ROMﾊﾞｰｼﾞｮﾝ Ver.2.0 及びそれ以降）ではこのSDKを単に”eBUS SDK”と呼称します．

但し，正式には”eBUS-PureGEV Package”と規定されている為，説明の中ではこの呼称を用いて説明する場合が有ります．

［重要］アプリケーション開発時のＳＤＫ選択について

本製品ではIPエンジンにカナダPleora社のiPORTを採用しています．

iPORTではＳＤＫとして （GenICam API に対応した開発環境）と （GenICam APIには非”eBUS SDK” ”eBUS-Vision Package””eBUS SDK” ”eBUS-Vision Package””eBUS SDK” ”eBUS-Vision Package””eBUS SDK” ”eBUS-Vision Package”

対応）が利用出来ます．

デモ表示ソフト”Coyote”を含む”eBUS-Vision Package”は以前よりiPORT開発環境として長年使用されて来ましたが，

サードパーティーの画像処理ソフトウエアメーカーや多くのGigEカメラメーカーのカメラ製品でGenICam APIへの対応が

一般的になって来た現在，Pleora社では新規アプリケーションの開発環境としては”eBUS SDK”（GenICam API に対応した

開発環境）の使用を強く推奨しています．

従来よりご開発されて来たiPORTインターフェースやGigEカメラ用のアプリケーションがPleora社の”eBUS-Vision Package”

をプラットフォームとして開発されて来たものであるなど特別の理由が有る場合を除き，新たなユーザーアプリケーション

の開発はGenICam API に対応した開発環境である を用いて頂く事を推奨致します．”eBUS SDK””eBUS SDK””eBUS SDK””eBUS SDK”

（８－１）ｅＢＵＳ ＳＤＫ 関連ドキュメントファイルの参照

以下の手順でドキュメントファイルを参照する事が出来ます．

＜”Getting started”（開発の最初の手順）と ＡＰＩクラスライブラリの説明書＞

スタート → すべてのプログラム → Pleora Technologies Inc → eBUS SDK → API Doccumentation（クリック）

でこのドキュメント（chm 形式文書）が開かれます．

必要な箇所を選びプリンタでプリントアウトする事も出来ます．
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（８－２）ｅＢＵＳ ＳＤＫ を用いたコードサンプルの利用

スタート → すべてのプログラム → Pleora Technologies Inc → eBUS SDK → Code Samples（クリック）

でコードサンプルのフォルダが開かれます．

※それぞれのコードサンプルの説明は各フォルダ内の”ReadMe.txt”を参照して下さい．

（８－３）ｅＢＵＳ Ｖｉｓｉｏｎ Ｐａｃｋａｇｅ 関連ドキュメントファイルの参照

以下の手順でドキュメントファイルを参照する事が出来ます．

スタート → すべてのプログラム → Pleora Technologies Inc → eBUS-Vision Package → Doccumentation（クリック）

次頁図の様にブラウザが表示されます．

デフォルトでのインストールでは以下のディレクトリになります

C:\Program Files\Pleora Technologies Inc\eBUS SDK\Samples\..以下..

※各サンプルプログラムの内容については各個別フォルダ内の”Readme.txt”などを参照して下さい．

（注）本SDK のサンプルコードは”Microsoft Visual Studio 2005”を標準開発環境として作成されています．

（注）SDK の全ての著作権はカナダ Pleora Technologies Inc. が所有しています．

（注）使用条件についてはSDK のインストール時に示されるLisence Agreement の内容にご同意の上ご使用願います．
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ここで表示される各項目を選択し必要なドキュメントを表示させて下さい．

※収録されている文書の閲覧にはPDF フォーマットの文書が読み出せるソフトウエア（Adobe社／PDF Reader など）が必要です．

（８－４）ｅＢＵＳ Ｖｉｓｉｏｎ Ｐａｃｋａｇｅ コードサンプルの利用

以下の手順でＣ／Ｃ＋＋のサンプルコードのファイルを参照する事が出来ます．

スタート → すべてのプログラム → Pleora Technologies Inc → eBUS-PureGEV Package → Code Samples（クリック）

上図の様に Samples フォルダの内容が表示されます．
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デフォルトでのインストールでは以下のディレクトリになります

C:\Program Files\Pleora Technologies Inc\eBUS-Vision Package\Samples\..以下..

※各サンプルプログラムの内容については各個別フォルダ内の”Readme.txt”などを参照して下さい．

（注）本SDK のサンプルコードは”Microsoft Visual Studio 2005”を標準開発環境として作成されています．

（注）SDK の全ての著作権はカナダ Pleora Technologies Inc. が所有しています．

（注）使用条件についてはSDK のインストール時に示されるLisence Agreement の内容にご同意の上ご使用願います．

（８－５）SDK のアップデート

SDK のアップデートはご要求が有れば対応させて頂きますが，アップデートソフトウエアの送付に関わる諸費用（手数料，送料な

ど）は原則的に有償扱いとさせて頂きますのでご了承願います．

－ 以 上 －


